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Engineering Analysis with SOLIDWORKS Simulation 2021

2: Static analysis of a plate

Topics covered

Using the SOLIDWORKS Simulation interface

Linear static analysis with solid elements

Controlling discretization error with the convergence process
Finding reaction forces

Presenting FEA results in a desired format

Project description

Fixed restraint

A steel plate is supported and loaded, as shown in Figure 2-1. We assume that the
support is rigid. Rigid support is also called built-in support, fixed support, or
fixed restraint. A 100000N tensile load is uniformly distributed along the end
face, opposite to the supported face.

100000N tensile force
uniformly distributed
over the face

Figure 2-1: SOLIDWORKS model of a rectangular plate with a hole.

We will perform a displacement and stress analysis using meshes with different
element sizes. Notice that repetitive analysis with different meshes does not
represent standard practice in FEA. However, repetitive analysis with different
meshes produces results which are useful in gaining more insight into how FEA
works.
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Procedure

In SOLIDWORKS, open the model file called HOLLOW PLATE. Verify that
SOLIDWORKS Simulation is selected in the Add-Ins list (Figure).

Active —»

Figure 2-2: Add-Ins list in SOLIDWORKS.
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[[] & soLIDWORKS Design Checker
[ & soLIDWORKS Motion

[] & soLIDWORKS Routing

% SOLIDWORKS Simulation

[0 § sOLIDWORKS Toolbox Library
[  soLDWORKS Toolbox Utilities
[ &4 soLibworks utilities

Il EI TolAnalyst
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485
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Start Up

Verify that SOLIDWORKS Simulation is selected as Active Add-in and Start Up

Add-in.

Once Simulation has been added, it shows in the main SOLIDWORKS menu
and in the Command Manager.
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Simulation Pin down

A \
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Figure 2-3: The Simulation tab is a part of the SOLIDWORKS Command
Manager.

Selecting the Simulation tab in the Command Manager displays Simulation menu
items (icons). Since no study has yet been created, only the Study creation icon is
available; all others are grayed-out. For convenience, pin down the top tool bar
as shown. Command Manager with Large Buttons is shown in this illustration.

Notice that the Feature Manager Design Tree shown in Figure 2-3 displays
Solid Bodies and Surface Bodies folders. These folders can be displayed by
right-clicking anywhere in the Feature Manager Design Tree to bring up the
pop-up menu and selecting Hide/Show Tree Items. This will invoke System
Options- Feature Manager (not shown here). From there, Solid Bodies and
Surface Bodies folder can be selected to show. We will need to distinguish
between these two different bodies in later exercises. In this exercise these two
folders do not need to show.
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Before we create a study, let’s review the Simulation main menu (Figure 2-4)
along with its Options window (Figure 2-5).

‘775 SOLIDWORKS File Edit View Insert Tools | Simulation | Window Help
— 5

New Study
&« study. < in Simulation
Study Material > main menu
- = Loads/Fixture »
Features | Sketch | Evaluate | DimXpert | SOLIDWORKS
. — Contact/Gaps ’
>
;%\H%‘Q‘el Shells »
@ HOLLOW PLATE (Default<<Default> Tapalogy Susty '
v History Mesh ;
Sensors
» [&) Annotations
’ Solid Bodies(1) Run 4
Surface Bodies
§-% Material <not specified>
[] Front Plot Results »
[ Top List Results »
(1] Right Result Tools >
[, origin
» @] Boss-Extrudel
» (@ Cut-Extrudel T
Fatigue 4
Import Motion Loads...
& Options... <4——— Simulation
Options

Help »
About Simulation

Customize Menu

Figure 2-4: Simulation main menu.

Like the Simulation Command Manager shown in Figure 2-3, only the New Study
icon is available. Notice that some commands are available both in the Command
Manager and in the Simulation menu.

Simulation studies can be executed entirely from the Simulation drop down
menu shown in Figure 2-4. In this book we will use the Simulation main menu
and/or Command Manager to create a new Study.
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Click on the Simulation Options shown in Figure 2-4 to open the Simulation
Options window (Figure 2-5); select Default Options tab and Units from the
menu in Default Options.

Default Options

Default Options - Units X

System Options Default Options

Units —» | ums
Interaction Lnitisysten
Load/Fixture @51 (Mks)
Mesh (english (ps)
Solver and Results O Metric (G)
=-Plot
© -Color Chart Units
& Default Plots Length/Displacement: mm v
=¥ Static Study Results
| & Plot1 Temperature: Kelvin N
& pior2 angular velocity: radsec v Set Pressure/Stress
: qu?r:\oﬁ Pressure/Stress: N/mm#2(h >~ ¢ .
quency/Buckling Study Results unit to MPa
f‘-D.Sgerma\ Study Results
. Plot1
=@ Drop Test Study Results
-Brion
B rior2
Brio3
=4 Fatigue Study Results
| - ®piot1
% pior2

Eviomw'mw'zanon Study Results
=] dé Nonlinear Study Results
% piot1
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@ piot3
=@ Mesh Plot
B riot1
User information
Report

concel T

Figure 2-5: Simulation Options window.

The Options window has two tabs: system Options and Default Options. In this
illustration, Default Options tab is shown.

In the Units options, make the choices shown in Figure 2-5. In this book we will
mostly use the SI system of units using MPa rather than Pa as a unit of stress and
pressure. Occasionally we will switch to the IPS system.

Notice that Default Plots can be added, modified, deleted, or grouped into sub-
folders which are created by right-clicking on the results folders, for example,
Static Study Results folder, Thermal Study Results folder, etc.

In this chapter we will return to Default Options (Figure 2-5) twice to review
choices in Mesh and in Solver and Results.
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Creation of an FEA model starts with the definition of a study. To define a new
study, select New Study in either the Simulation tab in the Command Manager
(Figure 2.3) or Simulation main menu (Figure 2-4). This will open the Study
Property Manager. Notice that the New Study icon in the Simulation Command
Manager can also be used to open the Study Advisor. We won't be using the
Study Advisor in this book. Name the study tensile load 01 (Figure 2-6).

/77SSOLIDWORKS File Edit View Insert Tools Simulation Window Help b
] |

<«
Study
New Study button in the 0
Simulation tab can & New Study Xpert | SOLIDWORKS Add-Ins | Simulation | Analysi

also be used to open 7 & Simulation Advisor

the Simulation Advisor

Study @& @
v X ™
Message v
Name ~

Enter study name — iy ko 91

General Simulation ~
Select Static — Static

[ use 2D simplification

{Qu Frequency

Design Insight v :|
Advanced Simulation v
Specialized Simulation v

Figure 2-6: Creating a new study.

The study definition window offers choices of the type of study, here we select
Static. Static study and Frequency study belong to the group called General
Simulation.
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Once a new study has been created, Simulation Commands can be invoked in
three ways:

e From the Simulation Command Manager (Figure 2-4)

e From the Simulation main menu (Figure 2-4); in this book, we will most often
use this method

When a study is defined, Simulation creates a study window located below the
Feature Manager Design Tree and places several folders in it. It also adds a
study tab located next to Model and Motion Study tabs. The tab provides access
to the study (Figure 2-7). We won't be using the Motion Studies in this book.

2
2S SOLIDWORKS File Edit View Insert Tools Simulation Window X ﬁ D

. . ) e
Simulation « = ® B 1 i
Command ——pp  New Study Apply Simulation Fixtures Advisor External Loads Advisor Connections Advisor
M Material Evaluator
anager = w2 ~

Simulation study
window

Features ‘ Sketch \ Evaluate | SOLIDWORKS Add-Ins ‘ Simulation | Analysis Preparati

SEE[S]®] -

i
@ HOLLOW PLATE (Default<<D A
> History

Sensors v
< >

-
X tensile load 01 (-Default-)

© 4 HOLLOW PLATE
§] Connections jl

B Fixtures
14 External Loads
& Mesh

Result Options

[AIT1F 1] Model | Motion Study 1 | ¥ tenslie load 01 |

f f

SOLIDWORKS Simulation
Model tab Study tab

Figure 2-7: The Simulation window and Simulation tab.

You can switch between the SOLIDWORKS Model and Simulation Studies by
selecting the appropriate tab.
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We are now ready to define the analysis model. This process generally consists of
the following steps:

e CAD geometry idealization and/or simplification in preparation for
analysis. This is usually done in SOLIDWORKS by creating an analysis
specific configuration and making your changes there

e Material properties assignment
e Restraints definition

e Loads definition

In this case, the geometry does not need any preparation because it is already very
simple; we can start by assigning material properties.

Notice that if a material is defined for a SOLIDWORKS part model, the material
definition is automatically transferred to the Simulation model. Assigning a
material to the SOLIDWORKS model is a preferred modeling technique,
especially when working with assemblies consisting of parts with different
materials. We will do this in later exercises.

To apply material to the Simulation model, right-click the HOLLOW PLATE
folder in the tensile load 01 simulation study and select Apply/Edit Material
from the pop-up menu (Figure 2-8).
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Figure 2-8: Assigning material properties.

The left window shows the first step in the process of applying material properties
to the model. The right window shows modification to System Options, this needs

to be done only once.
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The action in Figure 2-8 opens the Material window shown in Figure 2-9.
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Figure 2-9: Material window.

Select Alloy Steel to be assigned to the model; select MPa as units.
Click Apply, and then click Close.
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In the Material window, the properties are color coded to indicate the mandatory
and optional properties. Red color (Elastic modulus, Poisson’s ratio, Mass
Density, Yield Strength) indicates a property that is mandatory based on the active
study type and the material model. Blue color (Tensile strength, Compressive
Strength, Thermal expansion coefficient) indicates optional properties. A black
color description indicates properties calculated from the mandatory properties
(Shear Modulus) or properties not applicable to the current study.

The analysis will not use volume loads; therefore, Mass Density will not be used.

In the Material window, open the SOLIDWORKS Materials menu, followed by
the Steel menu. Select Alloy Steel. Select SI units under the Properties tab (other
units could be used as well). Notice that the HOLLOW PLATE folder in the
tensile load 01 study now shows a check mark and the name of the selected
material to indicate that a material has been assigned. If needed, you can define
your own material by selecting Custom Defined material.

Material definition consists of two steps:

e Material selection (or material definition if a custom material is used)

e Material assignment (either to the entire model, to selected bodies of a
multi-body part, or to selected components of an assembly)

Having assigned the material, we now move to defining the restraints. To display
the pop-up menu that lists the options available for defining restraints, right-click
the Fixtures folder in the tensile load 01 study (Figure 2-10).
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Gi* tensile load 01 (-Default-)
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0y Copy
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Figure 2-10: Pop-up menu for the Fixtures folder and Fixture definition window

(Fixture Property Manager).

All restraints’ definitions are done in the Type tab. The Split tab is used to define
a split face where restraints are applied. The same can be done in SOLIDWORKS
by defining a Split Face.
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Once the Fixtures definition window is open, select the Fixed Geometry restraint
type. Select the end-face entity where the restraint is to be applied. Click the
green check mark in the Fixture Property manager window to complete the
restraint definition.

Notice that in SOLIDWORKS Simulation, the term “Fixture” implies that the
model is firmly “fixed” to the ground. However, aside from Fixed Geometry,
which we have just used, all other types of fixtures restrain the model in certain
directions while allowing movements in other directions. Therefore, the term
“restraint” may better describe what happens when choices in the Fixture window
are made. In this book we will switch between the terms “fixture” and “restraint”
freely.

The existence of restraints is indicated by symbols shown in Figure 2-10. In the
Symbol Settings of the Fixture window, the size of the symbol can be changed.
Notice that symbols shown in Figure 2-10 are distributed over the highlighted face
meaning the entire face has been restrained. Each symbol consists of three
orthogonal arrows symbolizing directions where translations have been restrained.
Each arrow has a disk symbolizing that rotations have also been restrained. The
symbol implies that all six degrees of freedom (three translations and three
rotations) have been restrained. However, the element type we will use to mesh
this model (second order solid tetrahedral element) has only translational degrees
of freedom. Rotational degrees of freedom can't be restrained because they don't
exist in this type of element. Therefore, disks symbolizing restrained rotations are
irrelevant in our model. Please see the following table for more explanations.

Before proceeding, explore other types of restraints accessible through the
Fixture window. Restraints can be divided into two groups: Standard and
Advanced. Review animated examples available in the Fixture window and
review the following table. Some less frequently used types of restraints are not
listed here.
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Standard Fixtures

Fixed Also called built-in or rigid support. All translational and all
rotational degrees of freedom are restrained.
Only translational degrees of freedom are restrained, while
Immovable rotational degrees of freedom remain unrestrained.

(No translations)

If solid elements are used (like in this exercise), Fixed and
Immovable restraints would have the same effect because
solid elements do not have rotational degrees of freedom.
Therefore, the Immovable restraint is not available if solid
elements are used alone.

Roller/Slider

Specifies that a planar face can move freely on its plane but
not in the direction normal to its plane. The face can shrink or
expand under loading.

Fixed Hinge

Applies only to cylindrical faces and specifies that the
cylindrical face can only rotate about its own axis. This
condition is identical to selecting the On cylindrical face
restraint type and setting the radial and axial components to
zZero.

Advanced Fixtures

Symmetry

Applies symmetry boundary conditions to a flat face.
Translation in the direction normal to the face is restrained
and rotations about the axes aligned with the face are
restrained.

Cyclic symmetry

Allows analysis of a model with cyclic patterns around an
axis by modeling a representative segment. The geometry,
restraints, and loading conditions must be identical for all
other segments making up the model. Turbine, fans,
flywheels, and motor rotors can usually be analyzed using
cyclic symmetry.

Use Reference

Restrains a face, edge, or vertex only in certain directions,
while leaving the other directions free to move. You can

Geometry specify the desired directions of restraint in relation to the
selected reference plane or reference axis.
Provides restraints in selected directions, which are defined
On Flat Faces by the three directions of the flat face where restraints are

being applied.

On Cylindrical
Faces

This option is similar to On flat face, except that the three
directions of a cylindrical face define the directions
of restraints.

On Spherical Face

Similar to On Flat Faces and On Cylindrical Faces. The
three directions of a spherical face define the directions
of the applied restraints.
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When a model is fully supported (as it is in our case), we say that the model does
not have any rigid body motions (the term “rigid body modes” is also used),
meaning it cannot move without experiencing deformation.

Notice that the presence of restraints in the model is manifested by both the
restraint symbols (showing on the restrained face) and by the automatically
created icon, Fixture-1, in the Fixtures folder. The display of the restraint
symbols can be turned on and off by either:

e Right-click Fixtures folder and select Hide All or Show All in the pop-up
menu shown in Figure 2-10

or

e Right-click fixture icon and select Hide or Show from the pop-up menu.

Use the same method to control display of other Simulation symbols.
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To define the load right-click the External Loads folder and select Force from the
pop-up menu. This action opens the Force window as shown in Figure 2-11.

Q\* tensile load 01 (-Default-)
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@ Mesh
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Result Op 1 Force..
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3 Temperature...

Ei Prescribed Displacement...

A¥ Flow Effects...
Thermal Effects...

di Remote Load/Mass...
@ Distributed Mass...

Gy copy

N\ Hide All
@ Show All

1> Create New Folder

B* Collapse Tree Items
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v X ™
Force/Torque A
Force —

@ Il—‘ —

@ Normal ]

(O selected direction
ERE v
4 [0 v]n
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[INonuniform Distribution ™
Symbol Settings A
_ Edit Color...
11l | 200

Show preview

o Force Value (N):‘ 100,000 |
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This window shows
geometric entities
where loads are applied

4-':—— Symbol size: 200

Figure 2-11: Pop-up menu for the External Loads folder and Force window.

The Force window displays the selected face where the tensile force is applied. If
only one entity is selected, there is no distinction between Per Item and Total. In
this illustration, load symbols have been enlarged by adjusting the Symbols
Settings. Symbols of previously defined restraints have been hidden.
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In the Type tab, select Normal in order to load the model with a 100000N tensile
force uniformly distributed over the end face, as shown in Figure 2-11. Check the
Reverse direction option to apply a tensile load.

Generally, forces can be applied to faces, edges, and vertices using different
methods, which are reviewed below:

Force normal Available for flat faces only, this option applies load in
the direction normal to the selected face.

Force selected direction | This option applies a force or a moment to a face,
edge, or vertex in the direction defined by the selected
reference geometry.

Moments can be applied only if shell elements are used.
Shell elements have six degrees of freedom per node:
three translations and three rotations. Nodes of shell
element can take a moment load.

Solid elements only have three degrees of freedom
(translations) per node and, therefore, cannot take a
moment load directly.

If you need to apply moments to solid elements, they
must be represented with appropriately applied forces.

Torque This option applies torque (expressed by traction
forces) about a reference axis using the right-hand rule.

Try using the click-inside technique to rename the Fixture-1 and Force/Torque-1
items. Notice that renaming using the click-inside technique works on all items in
SOLIDWORKS Simulation.

The model is now ready for meshing. Before creating a mesh, let’s make a few
observations about defining the geometry, material properties, loads and
restraints.

Geometry preparation is a well-defined step with few uncertainties. Geometry that
is simplified for analysis can be compared with the original CAD model.

Material properties are most often selected from the material library and do not
account for local defects, surface conditions, etc. Therefore, the definition of
material properties usually has more uncertainties than geometry preparation.

The definition of loads is done in a few menu selections but involves many
assumptions. Factors such as load magnitude and distribution are often only
approximately known and must be assumed. Therefore, significant idealization
errors can be made when defining loads.
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Defining restraints is where severe errors are most often made. For example, it is
easy enough to apply a fixed restraint without giving too much thought to the fact
that a fixed restraint means a rigid support — a mathematical abstraction. A
common error is over-constraining the model, which results in an overly stiff
structure that underestimates displacements and stresses. The relative level of
uncertainties in defining geometry, material, loads, and restraints is qualitatively
shown in Figure 2-12.

Geometry Material Loads Restraints

Figure 2-12: Qualitative comparison of uncertainty in defining geometry, material

properties, loads, and restraints.

The level of uncertainty (or the risk of error) has no relation to time required for
each step, so the message in Figure 2-12 may be counterintuitive. In fact,
preparing CAD geometry for FEA may take hours, while defining material
properties and applying restraints and loads takes only a few clicks.

In all of the examples presented in this book, we assume that definitions of
material properties, loads, and restraints represent an acceptable idealization of
real conditions. However, we need to point out that it is the responsibility of the
FEA user to determine if all those idealized assumptions made during the creation
of the mathematical model are indeed acceptable.

Before meshing the model, we need to verify under the Default Options tab, in
the Mesh properties, that High quality, Standard mesh is selected (Figure 2-13).
The Options window can be opened from the SOLIDWORKS Simulation menu
as shown in Figure 2-4.
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3 Default Options - Mesh
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[“] automatic re-alignment for non-composite shells

D Render beam profiles and shell thicknesses (slower)

Help...

Cancel |

Figure 2-13: Mesh settings in the Default Options window.

Mesh quality: High

<4— Mesh type: Standard

High Mesh quality means that the second order elements are used. Standard mesh
type is one of three types of meshed available in SOLIDWORKS Simulation. We
will use curvature based meshes in later exercises.
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The element order is visually indicated by a tetrahedron symbol next to Solid
Body symbol in Study window. Tetrahedron with straight edges indicates the first
order element. Tetrahedron with curvilinear edges indicates the second order
element (Figure 2-14). If more than one body are present in a Simulation study,
they can be meshed with different element order mesh. The current study has only
one body called HOLLOW PLATE after the study name.

The difference between High and Draft mesh quality is:

e Draft quality mesh uses first order elements
e High quality mesh uses second order elements

Differences between first and second order elements were discussed in chapter 1.

The difference between Curvature based mesh and Standard mesh will be
explained in chapter 3. Now, right-click the Mesh folder to display the pop-up
menu (Figure 2-14).

Blue tetrahedron with @X tensile load 01 (-Default-)
curvilinear edges indicates —p 1 4, HOLLOW PLATE (-Alloy Steel-)
high quality mesh §3 Connections
4 @) Fixtures
» 1} External Loads

Right-click —

@ Mesh Advisor...

Mesh to display Result Option
mesh pop up menu B Simplify Model for Meshing
@ Create Mesh... < Create Mesh

Mesh and Run

@ Apply Mesh Control...
Failure Diagnostics...
E2 Details...

@ Create Mesh Quality Plot...
[@ Mesh Quality Diagnostics...

' Hide All Mesh Control Symbols
@ Show All Mesh Control Symbols

0y Copy
£+ Collapse Tree Items

Figure 2-14: Mesh pop-up menu.

Select Create Mesh from the pop-up menu.
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In the pop-up menu, select Create Mesh. This opens the Mesh window (Figure 2-
15) which offers a choice of element size and element size tolerance.

This exercise demonstrates the impact of mesh size on results. Therefore, we will
solve the same problem using three different meshes: coarse, medium (default),
and fine. Figure 2-15 shows the respective selection of meshing parameters to
create the three meshes. All three studies use the High Quality (second order)
elements.

Mesh @ Mesh @ Mesh @
v X X v X
Definition | Mesh Quality Definition | Mesh Quality Definition | Mesh Quality
Mesh Density ~ Mesh Density ~ Specify ~
B ' B ' 4 High:
' . HOLLOW PLATE
Coarse Fine Coarse Fine
Reset | Reset
Issue warning for distorted Issue warning for distorted
elements elements
[IMesh Parameters s [¥]Mesh Parameters ~
O slended curvature-based mesh O Blended curvature-based mesh m
() curvature-based mesh O curvature-based mesh q r ) — 9
; “][¥][~][= -
@ standard mesh @ standard mesh
& Draft:
E mm M G mm ~
& | 572453318mm v [T 4 | 286226659mm v o
RRRERRRRRENE) I FTTRNRRERRERNRRNRERRRERRECCT (T ]
B | 286226659m = =
@ |8
ah |14 N M=
Default Fine Mesh quality

Figure 2-15: Three mesh sizes: coarse, default, fine and mesh quality: high.

Show Mesh Parameters to see the element size. In all three cases use Standard
mesh. Notice different slider positions in the three windows.

In all three cases use High Quality mesh (second order elements). Use Definition
tab and Mesh Quality tab to switch between the above windows.

The medium mesh density (size), shown in the middle window in Figure 2-15, is
the default that SOLIDWORKS Simulation proposes for meshing our model.
The element size of 5.72 mm and is established automatically based on the
geometric features of the model. The 5.72 mm size is the characteristic element
size in the mesh, as explained in Figure 2-16.
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Tetrahedral element Triangular element

Figure 2-16: Characteristic element size of a tetrahedral element (left) and a
triangular element (right).

The characteristic element size of a tetrahedral element can be defined as
diameter h of a circumscribed sphere. This is easier to illustrate with a 2D
analogy of a circle circumscribed on a triangle.

Element size has a direct impact on the accuracy of results. The smaller the

elements, the lower the discretization error, but the meshing and solving time both
take longer.
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Right-click the Mesh folder again and select Create... to open the Mesh window.
With the Mesh window open, set the slider all the way to the left (as illustrated in
Figure 2-15, left) to create a coarse mesh, and click the green checkmark button.

The mesh will be displayed as shown in Figure 2-17.

@ tensile load 01 (-Default-)
& <l HOLLOW PLATE (-Alloy Steel-)
g1 Connections
4 ‘»'3) Fixtures
» 14 External Loads
> @ Mesh
= Mesh Quality Plot
= o
@ Hide

Result Options

W@} Edit Definition...
Settings...

7 Axes...

/ Probe and List Selected
@) Mesh Sectioning...

g Print...

Save As ...

X Delete...
Oy Copy

E* Collapse Tree Items
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Figure 2-17: A coarse mesh created with second order, solid tetrahedral elements.

You can control the mesh display by selecting Hide Mesh or Show Mesh from the
pop-up menu in mesh plot. Here the plot is named Quality 1. Activate the pop-up

menu by Right-click Quality 1 plot.
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The presence of a mesh is reflected in the appearance of the solid folder and the
mesh folder in a Simulation study (Figure 2-18).

© &) HOLLOW PLATE § <4 HOLLOW PLATE

@ Mesh @ Mesh

Before meshing After meshing

Figure 2-18: Solid folder and mesh folder in a Simulation study before and after
meshing.

After meshing, cross hatching is added to the Solid Body symbol. Assigning
material properties adds a green check mark to the Solid Body symbol.

After meshing, cross hatching and a green check mark is added to Mesh folder.

When Solid folder contains more than one body, High Quality and Draft Quality
meshes may be individually selected for each body. We do not use this option in
this exercise.
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To start the solution, right-click the tensile load 01 study folder which displays a
pop-up menu (Figure 2-19). Select Run to start the solution.

C¥ tenslie load 01 (-Defa!EIR \ .
& 4 HoLLow PLAT| © =" <— Run solution

i ® Update All Components
g1 C‘onnectlons i
v @) Fixtures =
¥ Fixed-1 & Trend Tracker

v L} External Loads | ¥ Create Submodeling Study
‘ 3 Force-1 (Per it W Load Case Manager
Mesh o Copy Study
Result Options | @ shell Manager
ﬁ Simulation Evaluator...
@ Plot Imported Results...

IE Details...
Properties...
GE Mass Properties...

| Define Function Curves...

Rename
X Delete

Figure 2-19: Pop-up menu for the tensile load 01 folder.

Start the solution by right-clicking the tensile load 01 folder to display a pop-up
menu. Select Run to start the solution.
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The solution can be executed with different properties, which we will investigate
in later chapters. You can monitor the solution progress while

the solution is running (Figure 2-20).

M tensile load 01

Solving:
A 18.2%
Elapsed Time:

Pause Cancel

Always show solver status when you run analysis

More>>

Figure 2-20: Solution Progress window.

The solver reports solution progress while the solution is running.

If the solution fails (not in this exercise), the failure is reported as shown in Figure

2-21.

Simulation

Q I\Io restraints are defined.

You may use Soft Spring or Inertia Relief options.

See SOLIDWORKS Knowledge Base solution S-074275

OK

Figure 2-21: Failed solution warning windows.

| HOLLOW PLATE-tensile load 01 : Failed

Here, solution of a model with no restraints was attempted. Once the error
message has been acknowledged (left), the solver displays the final outcome of the

run (right).

When the solution completes successfully, Simulation creates a Results folder
with result plots which are defined in Simulation Default Options as shown in

Figure 2-5.
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In a typical configuration three plots are created automatically in the Static study;
make sure that the above plots are defined in Simulation options, if not, define

them:
o Stressl showing von Mises stresses
e Displacementl showing resultant displacements
o  Strainl showing equivalent strain

Once the solution completes, you can add more plots to the Results folder. You
can also create subfolders in the Results folder to group plots (Figure 2-22).

¥ tensile load 01 (-Default-) &3 Results Advisor..
@ £} HOLLOW PLATE (-Alloy Steel-)
@] Connections Solver Messages...
i fﬁ Fixtures @ Stress Hot Spot Diagnostics...
: : : L4 External Loads
ng}(lit.' 011“‘1( Iliesullts Options » & Mesh ®" Define Factor Of Safety Plot..
to display Results Optlon ~~ Result Options @' Define Stress Plot...
- Results & Define Displacement Plot...
Right-click — [ stress1 (-vonMises-) & Define Strain Plot...
Results folder @' Displacement1 (-Res disp-) B5 Define Design Insight Plot...
to invoke @& Strain1 (-Equivalent-) @ Define Fatigue Check Plot..
. . T =
window on the right & Results Equations..

List Stress, Displacement, Strain
[ﬁ List Result Force...

Result Options ©) B Compare Results..
v X
Create Body from Deformed Shape...

Msesge = & Save All Plots as JPEG Files
Displacements and reactions are = <
always calculated. Not storing i@ Save All Plots as eDrawings
stresses and strains, saves disk space [h T
Quantities to save into file ~ E Creste New Folder

Stresses and strains E' Eollapse Troe [forms

Figure 2-22: More plots and folders can be added to the Results folder.

Right-clicking on the Results folder activates this pop-up menu from which plots
may be added. Three plots are automatically created if Results Options include
these three plots: Stress, Displacement, Strain. You may define additional plots.
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The Result Options window shown in Figure 2-22 has different choices
depending on the type of study. In a Static study, deselecting Stress and strain
disables calculation of stress and strain which reduces calculation time and the
size of solution data base. This may be important in analysis of very large models.

To display stress results, double-click on the Stress1 icon in the Results folder or
right-click it and select Show from the pop-up menu. The stress plot is shown in
Figure 2-23.

von Mises (N/mm*2 (MPa))

3399%e+02

l 3.08%+02
. 2778e+02

_ 2467e+02
2.157e+02
1.846e+02
1.536e+02
1.225e+02
9.143e+01
6.037e+01

2.931e+01

—Pp Yield strength: 6.204e+02

Figure 2-23: Stress plot displayed using default stress plot settings.

Von Mises stress results are shown by default in the stress plot window. Notice
that results are shown in [MPa] as was set in the Default Options tab shown in
Figure 2-5. The highest stress 345 MPa is below the material yield strength, 620
MPa.

Once the stress plot is showing, right-click the stress plot icon to display the pop-
up menu featuring different plot options (Figure 2-24).
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@ Hide

@} Edit Definition...
fe Chart Options...
Settings...

» Animate..

# Section Clipping...
@ Iso Clipping...

% Mesh Sectioning...
# Probe

R List Selected

=% Deformed Result
@3 Compare Results...

G"Stressplot
v X -

Definition [ Chart Options‘ Settings]

Display

5 WVON: von Mises Stress

B 'N/mma2 (pa)
Advanced Options
Deformed shape

Property

Edit Definition

Edit Definition

<€— Chart Options

Settings

Gqsuess plot
v X

Definition | Chart Options | Settings

Display Options

[CIshow min annotation
[ show max annotation
Show plot details

[¥] show legend

Show Min/Max range on shown
parts only

Automatically defined maximum
value

Chart Options

Figure 2-24: Plot display options.

& Stress plot @
v X -

Deﬁnition| Chart Options[ Settings \

Fringe Options ~
Continuous =
Boundary Options A
Model £
Deformed Plot Options v
Settings

Plots can be modified using selections from the pop-up menu (top). The same
menus may by invoked by right-clicking the color legend of result plots.
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Explore all selections offered by these three windows shown in Figure 2-24.
Select scientific, floating and general format and color Options in Chart Options.
Notice that you may switch between Definition, Chart Options and Settings
either by using the pop-up menu shown in Figure 2-24 or by using tabs at the top
of these windows.

Use Edit Definition to change units if necessary. Chart Options offers control
over the format of numerical results, such as scientific, floating, and general, and
offers a different number of decimal places. Explore these choices. In this book,
results will be presented using different choices most suitable for the desired plot.
In many plots in this book Color Options will be User Defined to replace dark
blue color with grey color which shows better in print. Figure 2-24 shows the
User Defined menu. Position of the color legend may be modified for improved
layout.

The default type of Fringe Options in the Settings window is Continuous
(Figure 2-24). Change this to Discrete through the Default Options window, by
selecting Plot (Figure 2-5). This way you will not have to modify the future plots
individually. In this book we will be using Discrete Fringe Options to display
fringe plots. The plots from the current study will not change after changing the
Default Options.

Since the above change does not affect already existing plots, we now examine
how to modify the stress plot using the Settings window shown in Figure 2-25. In
Settings, seclect Discrete in Fringe options and Mesh in Boundary options. In
Chart Options select floating numerical format with one decimal place.
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The edited stress plot is shown in Figure 2-25.

&5 Stress plot @
v X ~

Definition | Chart Options | Settings

Display Options v von Mises (N/mm#2 (MPa))

Position/Format ~ 3399

Predefined positions.

ajmo
. o
 CON -
"E" Normal v
{2 floating ~ Z|

xm’1 |A

1328

107.0
Use 1000 separator

811

% Stress plot @ b3

v X M

29.3

— Yield strength: 620.4
Definition | Chart Options | Settings \

Fringe Options o]
Discrete v

Boundary Options Lol
Mesh v

Figure 2-25: The modified stress plot is shown with floating numerical format
with one decimal place as selected in Chart Options and with discrete fringes and

the mesh superimposed on the stress plot as selected in Settings.

The stress plot in Figure 2-25 shows node values, also called averaged stresses.
Element values (or non-averaged stresses) can be displayed by proper selection in
the Stress Plot window in Advanced Options. Node values are most often used
to present stress results. See chapter 3 and the glossary of terms in chapter 23 for
more information on node values and element values of stress results.

Before you proceed, investigate stress plot with other selections available in the
windows shown in Figure 2-24.
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We now review the displacement and strain results. All these plots are created and
modified in the same way. Sample results are shown in Figure 2-26
(displacement) and Figure 2-27 (strain).

[ Displacement plot @ [ Displacement plot @
v X + v X M
Definition | Chart Options | Settings Definition | Chart Options | Settings
Display A Display A
@ URES: Resultant Displacement ba G URES: Resultant Displacement o
E mm v E mm ~
Advanced Options : Advanced Options b
~| Deformed sha A | Deformed sha A
pe pe
(@ Automatic (@ Automatic
Dp 169.7046814 Dp 169.7046814
(O True scale j (O True scale ]
(O user defined (O user defined
0o ! 0o *
e ["Jshow colors — Show colors

URES (mm)
0.1179
0.1080
00982

_ 00884
00786
0.0688
0.0589
0.0491
00393

. 00295

_ 0019
_ 00098

0.0000

Deformed shape plot Displacement plot

Show colors deselected Show colors selected

Figure 2-26: Deformed shape plot (left) and Displacement plot (right).

A Displacement plot can be turned into a Deformation plot by deselecting Show
Colors in the Displacement Plot Definition window. The same window has the
option of showing the model with an exaggerated scale of deformation as shown
above. Both plots show the deformed shape; this option may also be deselected.
The blue color in the Displacement plot has been replaced with a gray color for
better appearance in this illustration. That was done in Chart Options, Color
Options, User defined. Numerical format specifies four decimal places.
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ESTRN
1.261e-03

1.166e-03

1.072e-03

_ 9.776e-04
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6.943e-04

5.999e-04

5.055e-04

4,111e-04

3.166e-04

2.222e-04

1.278e-04

Figure 2-27: Strain plot.

Strain plot is shown using Element values. The mesh is also shown.

The plots in Figures 2-23, 2-25, 2-26, 2-27 all show the deformed shape in an
exaggerated scale. You can change the display from deformed to undeformed or
modify the scale of deformation in the Displacement Plot, Stress Plot, and
Strain Plot windows, activated by right-clicking the plot icon, then selecting Edit
Definition.

Now, construct a Factor of Safety plot using the menu shown in Figure 2-22. The
definition of the Factor of Safety plot requires three steps. Follow steps 1 through
3 using the selection shown in Figure 2-28. Refer to chapter 1 and review Help to
learn about failure criteria and their applicability to different materials.
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Click right arrow to move

through windows Help
& Factor of Safety (& Factor of Safety ©) @ Factor of Safety @
v X ® v X ® ® v X ®
Message ~ Step 2 of 3 ~ Step 3 of 3 A
For Ductile materials use Max von Mises stress E N/mm~2 (MPa) - (O Factor of safety distribution
or Max Shear stress criterion.
Sot stress e (@ Areas below factor of safety
et stress i
For Brittle materials use Mohr-Coulomb stress l 3
or Maximum Normal stress criterion. @ vield strength
(O Uttimate strength Safety result
Step 1 of 2 ~ ; Based on the maximum von Mises
o O User defined stress criterion:
1 Minimum factor of safety:
(O selected bodies 1.82523
%? Max von Mises Stress v Multiplication factor
L |
OvonMises 1
T Limie <1 Beam Results: J
Advanced Options v[ it
Shell Results:
Property v
@ Minimum
Material involved
‘
Yield strength:
620.422 N/mm*2 (MPa)
Ultimate strength:
723.826 N/mm#2 (MPa)
Step 1 Step 2 Step 3
Use von Mises Stress criterion. Select stress limit and Select “Areas below factor of safety”
Review Property options to multiplication factor enter 3

insert text and/or use specific
views for the plot

Figure 2-28: Three windows show the three steps in the Factor of Safety plot
definition. Select the Max von Mises Stress criterion in the first window.

To move through steps, click on the right and left arrows located at the top of the
Factor of Safety dialog.

Step 1 selects the failure criterion, Step 2 selects display units, sets the stress limit
and sets multiplication factor, Step 3 selects what will be displayed in the plot.
Here we select areas below the factor of safety 3. Click green check mark to
display the plot.

Review Help to learn more about failure criteria.
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The factor of safety plot in Figure 2-29 shows the area where the factor of safety
is below the specified.

Model name: HOLLOW PLATE

Study name: tensile load 01(-Default-)
Plot type: Factor of Safety Factor of Safety1
Criterion : Max von Mises Stress

Red < FOS =3 < Blue

Figure 2-29: The red color displays the areas where the factor of safety falls below
3. Irregular shape of these areas is caused by the coarse mesh used in this study.

Mesh is shown. Custom colors are used to improve appearance of this plot in
print; light gray color has been substituted for default dark blue color.

We have completed the analysis with a coarse mesh and now wish to see how a
change in mesh density will affect the results. Therefore, we will repeat the
analysis two more times using medium and fine density meshes respectively. We
will use the settings shown in Figure 2-15. All three meshes used in this exercise
(coarse, default, and fine) are shown in Figure 2-30.

Figure 2-30: Coarse, medium, and fine meshes.

Three meshes used to study the effects of element size on results.
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To compare the results produced by different meshes, we need more information
than is available in the plots. Along with the maximum displacement and the
maximum von Mises stress, for each study we need to know:

e The number of nodes in the mesh

e The number of elements in the mesh

e The number of degrees of freedom in the model
The information on the number of nodes and number of elements can be found in

Mesh Details accessible from the menu in Figure 2-14. The mesh Details window
is shown in Figure 2-31.

Mesh Details LU S
Study name tensile load 01 (-Default-)
Mesh type Solid Mesh
Mesher Used Standard mesh
Automatic Transition Off
Include Mesh Auto Loops Off
Jacobian points for High quality mesh |16 points
Element size 11.4491 mm
Tolerance 0.572453 mm
Mesh quality High
Total nodes 2768
Total elements 1472
Maximum Aspect Ratio 6.5595
Pgn:entage of e_lements 99.9
with Aspect Ratio < 3 i
Percentage of elements 0
with Aspect Ratio > 10
% of distorted elements 0
(Jacohian)

Number of distorted elements 0
Time to complete mesh(hh:mm:ss) 00:00:00

Figure 2-31: Mesh details window.

Right-click the Mesh folder and select Details from the pop-up menu to display
the Mesh Details window. Information on the number of degrees of freedom is not
available here.
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Another way to find the number of nodes and elements and the only way to find
the number of degrees of freedom is to use the pop-up menu shown in Figure 2-
32. Right-click the Results folder and select Solver Messages to display the
window shown in Figure 2-32.

| Solver Message X

No. of nodes

2768
st 1472
elements
No. of DOF 8133

Total solution 00:00:00
time

| oK | Save

Figure 2-32: The Solver Message window lists information pertaining to the
solved study.

Total solution time was below 0.01s. Click the Save button to save this solver
message.

Now create and run two more studies. tensile load (2 with the default element
size (medium), and tensile load 03 with a fine element size, as shown in Figure 2-
15 and Figure 2-30. To create a new study, we could just repeat the same steps as
before, but an easier way is to copy the original study. To copy a study, follow the
steps in Figure 2-33.
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Copy Study @
v X *~
Message v
Source Study ~
C&* tensile load 01 v
Study name:

(4)

Enter new study name

Itensile load 02

Configuration to use:

Default v
@ tensile load 01 (-Default-) :
@ 4 HOLLOW PLATE (-Alloy Steel-) Target Study ~ 3)
¥ Connections Static ] = Select Static
o % Fixtures
QS’ Fixed-1 &‘ Nonlinear
N ia External Loads @ Linear Dynamic
4 Force-1 (:Per item: -100,000 N) '
% Mesh @ Topology Study
Result Options
- Results )
@“ Stress1 (-vonMises-) Copy Study <+ gQelect Copy Study
® Displacement1 (-Displacement-) Rename
& Strain1 (-Equivalent-) Delete
@ Factor of Safety1 (-Max von Mise Create New Motion Study
Create New Simulation Study
Create New Design Study

[W110 7| Model | 3DViews | MotionStudy 1 | ¥ tensile 1oaau1 |

T

)
Right-click study tab tensile load 01

Figure 2-33: A study can be copied into another study in three steps as shown.

Notice that all definitions in a study (material, restraints, loads, mesh) can also be
copied individually from one study to another by dragging and dropping them into
a different study tab.
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A study is copied complete with results and plot definitions. Before remeshing
with default element size, you must acknowledge the message shown in Figure 2-

34.

Simulation

I Remeshing will delete the results for study: tensile load 02.

O Do not show again

Cancel

o You can restore the suppressed messages from Simulation Options

> System options > Messages/Errors/Warnings.

Figure 2-34: Remeshing deletes existing results in the study.

The summary of results produced by the three studies is shown in Figure 2-35.

Max. resultant

Max. von Mises

Element size Number of Number of Number of DOF displacement stress
nodes elements
Study
mm mm MPa
tensile load 01 11.45 2768 1472 8133 0.117863 339.9
tensile load 02 5.72 12222 7040 36111 0.118068 369.8
tensile load 03 2.86 84112 54969 250851 0.118074 377.1

Figure 2-35: Summary of results produced by the three meshes.

Notice that these results are based on the same problem. Differences in the results
arise from the different mesh densities used in studies tensile load 01, tensile load

02, and tensile load 03.

The actual numbers in this table may vary slightly depending on the type of solver
and release of the software used for solution.

Figure 2-36 shows the maximum resultant displacement and the maximum von
Mises stress as a function of the number of degrees of freedom. The number of

degrees of freedom is in turn a function of mesh density.
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Figure 2-36: Maximum resultant displacement (top) and maximum von Mises

stress (bottom).

Both are plotted as a function of the number of degrees of freedom in the model.
The three points on the curves correspond to the three models solved. Straight
lines connect the three points only to visually enhance the graphs.

Having noticed that the maximum displacement increases with mesh refinement,
we can conclude that the model becomes “softer” when smaller elements are used.
With mesh refinement, a larger number of elements allows for better
approximation of the real displacement and stress field. Therefore, we can say that
the artificial restraints imposed by element definition become less imposing with
mesh refinement.
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Displacements are the primary unknowns in structural FEA, and stresses are
calculated based on displacement results. Therefore, stresses also increase with
mesh refinement. If we continued with mesh refinement, we would see that both
the displacement and stress results converge to a finite value which is the solution
of the mathematical model. Differences between the solution of the FEA model
and the mathematical model are due to discretization errors, which diminish with
mesh refinement.

We will now repeat our analysis of the HOLLOW PLATE by using prescribed
displacements in place of a load. Rather than loading it with a 100000N force that
caused a 0.118 mm displacement of the loaded face, we will apply a prescribed
displacement of 0.118 mm to this face to see what stresses this causes. For this
exercise, we will use only one mesh with the default (medium) mesh density.

Define a fourth study, called prescribed displ. The easiest way to do this

is to copy one of the already completed studies, for example study tensile load 02.
The definition of material properties, the fixed restraint to the left-side end-face
and mesh are all identical to the previous design study. We need to delete the
current External Loads (right-click the load icon and select Delete) and apply in
its place a prescribed displacement.

To apply the prescribed displacement to the right-side end-face, right-click the
Fixtures folder and select Advanced Fixtures from the pop-up menu. This opens
the Fixture definition window. Select On Flat Face from the Advanced menu
and define the displacement as shown in Figure 2-37. Check Reverse direction to
obtain displacement in the tensile direction. Notice that the direction of a
prescribed displacement is indicated by a restraint symbol.

Prescribed displacement may also be defined from the External Loads folder by
selecting Prescribed Displacement from the pop-up menu. This opens the same
Fixture definition window. Figure 2-37 illustrates both methods of defining
prescribed displacement.
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¥ prescribed displ (-Default-)
@ 43 HOLLOW PLATE (-Alio
g4 Connections

41 External L
@ Mesh X Fixed Geometry...
Result Op A Roller/Slider...
Fixed Hinge...
T8 Elastic Support...
@ Bearing Fixture...
{3 Foundation Bolt...
Advanced Fixtures...

4%) Eixtures Advisor...

. Hide All
@ Show All

Oy Copy
> Create New Folder

Bt Collapse Tree Items

Method 1
Using Fixture

@ prescribed displ (-Default-)
w <D HOLLOW PLATE (-Allo;
‘¥4 Connections
5 Fixtures
% Enx:rr]n e 14 External Loads Advisor...
Result( § Force..
& Torque..
4l Pressure...
o Gravity..

B Bearing Load...
4 Temperature...
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A% Flow Effects...
Thermal Effects...

& Femote Load/Mass...
§ Distributed Mass...

Method 2
Using External Loads

Fixture @
v X -
Type
1 @ ‘ Symmetry e
@ Cyclic Symmetry

@ Use Reference Geometry
On Flat Faces

ﬁ} On Cylindrical Faces

@ | On Spherical Faces

® I/—]

Translations ~
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E 0 mm
m 0 mm
0.118 ~ {mm

[CJReversq direction
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normal to face

On Flat Faces:

Normal to Face (mm):| 0.118

Figure 2-37: Two methods of defining prescribed displacement.

The prescribed displacement of 0.118 mm is applied to the same face where the

tensile load of 100000N was applied in previous studies.

Verify that the arrows (shown here in black color) are pointed away from the
selected face. Fixed restraints symbols on the other side are not shown.
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Once again, notice that the visibility of all loads and restraints symbols is
controlled by right-clicking the symbol and making the desired choice
(Hide/Show). All load symbols and all restraint (fixture) symbols may also be
turned on/off all at once by right-clicking the Fixtures or External loads folders
and selecting Hide all/ Show all from the pop-up menu.

Once a prescribed displacement is defined to the end face, it overrides any
previously applied loads to the same end face. While it is better to delete the load
in order to keep the model clean, a load has no effect if a prescribed displacement
is applied to the same entity in the same direction.

Figure 2-38 compares stress results for the model loaded with force to the model
loaded with prescribed displacement.
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168.6 169.9

139.8 1408
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248
Study: tensile load 02 Study: prescribed displ

Figure 2-38: Comparison of von Mises stress results.

Von Mises stress results with a load applied as a force (left) and von Mises stress
results with a load applied as a prescribed displacement (right).

Results produced by applying a force load and by applying a prescribed
displacement load are very similar but not identical. The reason for this
discrepancy is that in the model loaded by force, the loaded face does not remain
flat. In the prescribed displacement model, this face remains flat, even though it
experiences displacement as a whole. Also, while the prescribed displacement of
0.118 mm applies to the entire face in the prescribed displacement model, it is
only seen as a maximum displacement in one point in the force load model. You
may plot the displacement along the edge of the end face in study tensile load 02
by following the steps in Figure 2-39.
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Figure 2-39: Plotting displacement along the edge of the force loaded face in
study tensile load (2.

Right click the resultant displacement plot in the tensile load 02 study to invoke a
pop-up menu shown in the top left corner. Follow steps 1 through 4 to produce a
graph of displacements along the loaded edge. Repeat this exercise for a model
loaded with prescribed displacement to verify that the displacement is constant
along the edge.
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We conclude the analysis of the HOLLOW PLATE by examining the reaction
forces using the results of study tensile load (2. In the study tensile load 02, right-
click the Results folder. From the pop-up menu, select List Result Force to open
the Result Force window. Select the face where the fixed restraint is applied and
click the Update button. Information on reaction forces will be displayed as
shown in Figure 2-40.
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Figure 2-40: Result Force window.

Right-click the Results folder and follow steps 1 through 4 to analyze and display
reaction forces. Reaction forces can also be displayed in components other than
those defined by the global reference system. To do this, reference geometry such
as a plane or axis must be selected.
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A note on where Simulation results are stored: By default, all study files are
saved in the same folder with the SOLIDWORKS part or assembly model. Mesh
data and results of each study are stored separately in *.CWR files. For example,
the mesh and results of study tensile load 02 have been stored in the file:
HOLLOW PLATE-tensile load 02.CWR

When the study is opened, the CWR file is extracted into a number of different
files depending on the type of study. Upon exiting SOLIDWORKS Simulation
(which is done by means of deselecting SOLIDWORKS Simulation from the list
of add-ins, or by closing the SOLIDWORKS model), all files are compressed
allowing for convenient backup of SOLIDWORKS Simulation results.

The location of CWR files is specified in the Default Options window (Figure 2-
5). For easy reference, the Default Options window is shown again in Figure 2-
41.

The size of the CWR file may be reduced if stresses and strains are deselected in
the Results Options (Figure 2-22). We will not use this option.
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Figure 2-41: Location of solution database files.

You may use the SOLIDWORKS document folder or a user defined folder as

shown above.

Using the settings shown in Figure 2-41, the solution data base files are located in
folder c:\fea results. The default location is the SOLIDWORKS document folder.
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Models in this chapter
Model Configuration | Study Name Study Type
tensile load 01 Static
HOLLOW PLATE.sldprt Default tensile load 02 Static
tensile load 03 Static
prescribed displ Static
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